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Editorial 
By Ko Hla Min, EC 69 
Chief Editor 
 
It seems not very long ago when two organizations in the 
Bay Area decided to join forces to establish BAPS (Bay 
Area Professional Society. The venerable BEA (Burmese 
Engineering Association) and the youthful, energetic 
BASTS (Burmese American Science and Technology So-
ciety) were complementary; together they showed that 
"the sum of the parts can be greater than the whole". The 
founding members of BAPS were able to blend the age 
and experience seamlessly except for occasional greetings 
like "Uncle Benny" and "Uncle Maurice" by the younger 
EC members. 
 
Ko Benny was a classmate of the late James Shu (Ko 

President Message 
By Benny Tan 

 
 It has been more than a year since I was 
elected as President of BAPS. Time goes 
by so fast when you are busy! 2001 has 
been an exciting and extremely eventful 
year for BAPS. Our annual dinner was a 
great success because of a concerted team 
effort. Thus, I called it my “dream team.” 
The night was so popular that we were 
able to fill the restaurant to its maximum 
capacity! Last summer, our annual picnic 
was also a sold out event. We had to stop 
selling tickets near the end because of the 
limited capacity of our own in house 
cooking team. I can confidently say that 
everyone at the picnic really enjoyed our 
beef and chicken curry. The food received 
such rave reviews that by popular demand, 
we cooked the same thing again for the 
food fair at the St. Thomas Moore Church. 
We also took a very active roll in the In-
terfaith Memorial Service and Candlelight 
Vigil for the victims of the September 11, 
2001 tragedies in New York, Washington 
D.C., and Pennsylvania. This was the first 
time our Bay Area Burmese community 
was able to come together with other Bur-
mese religious and civic organizations to 
participate in a very special and successful 
event. Through our united efforts, we 
were able to raise $6,730 in donations for 
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Aung Khin), father of Eugene and Jonathan; so it was OK for them Ko Benny as "Uncle". Eugene and his 
soul mate May Mar Lim served in various capacities as the Executive Officers of BAPS. Jonathan, along 
with Daniel Maung (son of Saya Mao Toon Siong, former national table tennis champion of Burma/
Myanmar), designed, implemented and maintained the BAPS web site. Thanks to all EC members past and 
presented for their time, energy and contributions. Jonathan, a recent graduate of UC Berkeley, has tried 
hard to bring his friends to BAPS gatherings. We request our readers to give us suggestions on how we can 
really get fresh blood for BAPS. In this newsletter, Ko Benny writes about the accomplishments in his first 
year of BAPS presidency, and his plans for the coming year. 
  
Ko Maurice however does not feel comfortable when someone calls him "Uncle"; he has yet to celebrate 
the Big Five Oh. Maurice has worn several hats -- as the Financial Officer for the "First ever RIT Grand 
Reunion and Saya Pu Zaw Pwe", publisher [and now literally type-setting] the BAPS Newsletter, gourmet 
cook for the BAPS Annual Picnic, and as liasion for other professional organizations. In this newsletter, 
Ko Maurice presents an abridged version of his article "Advice to engineers who want to work in the US". 
Maurice is taking a crash course in web-site building to act as a back up for the BAPS web site. 
 
Ko Edison Paw, former president of BASTS, served as the first Vice President of BAPS. Despite his busy 
schedule, Ko Edison found time to write about selected Burmese/Myanmar enterpreneurs such as Ko 
David Ko and Ko Benny Tan. Ko Edison served and will continue to serve as Contributing Editor for the 
BAPS Newsletter.  
 
The BAPS newsletter was the brainchild of Ko Henry Lim (former Chief Editor), Saya U Nyo Win (the 
first BAPS President), and several Burmese American Professionals who wanted to share their knowledge 
and experience to fellow professionals in the Bay Area and beyond. Ko Henry has launched "Golden 
Padauk" -- the first bilingual magazine in the US. 
Saya U Nyo Win served two terms (the maximum allowed by the BAPS constitution) as the President; he 
continues to give advice to the BAPS officers. Kudos to the pioneers. 
 
A newsletter is more than a collection of articles and news; it could/should send out messages and ideas on 
how to improve the well being of the members. Some jokingly said that "Silicon Valley is now 'Silly Gone' 
valley with numerous layoffs and penny [or worthless] stocks". It's sad to see colleagues get pink slips. 
Can BAPS help them get training and/or jobs? We sincerely like everyone to be well off and prosperous. 
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the American Red Cross National Disaster Relief Fund.  
 
Our recent BAPS election meeting was both productive and exciting. We elected four new officers who 
bring much enthusiasm and spirit to the executive board. I would like to welcome all the new officers 
and current executive board members. Thank you all for your support. This coming year will be a great 
challenge for us. With the slowing economy and loss of consumer confidence nationwide, the Bay Area 
may be especially hard hit. Some of our friends and BAPS members may lose their jobs or experience 
difficult economic situations. I would like to call on all of our members to help all those who are af-
fected by such misfortune in everyway they can. 
 
We have come a long way in learning how to organize community events. It is also quite obvious that 
we need new young blood to expand beyond our present circle. This is our immediate challenge for the 
near future. In order to achieve this goal, we need to create more activities for younger generations, so 
that young people will be interested in joining our association and become more active members. It is a 
great opportunity for all of us to act young and be young at heart.  
   
I would like to take this opportunity and wish all of you happy holidays and best wishes for the coming 
year. Stay happy and healthy. 
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 A New Wave of Medicine  
by Linda Khaw  
 
A new direction In my last article, I wrote about my graduation from University of California, Berkeley. It has been over a year 
since I graduated from Cal. Currently, I am going to an Oriental Medicine school named Meiji College in Berkeley for a master 
degree in Oriental Medicine. My program is a 3-year, year-round program. I have just started school in September. I decided to 
study Oriental Medicine for many reasons. One of the reasons is my personal experience. About a year ago, I had a terrible 
cough right after a cold. I visited a primary doctor at Kaiser. She prescribed Robitussin, a common cough medicine. After listen-
ing to my lungs with stethoscope, she declared that my lungs are fine. I tried both Robitussin and Vicks, another over-the-
counter cough medicine, but my cough continued with no recovery in sight. The cough persisted for six months. I finally talked 
to a family friend in Los Angeles. She is a doctor, who is well versed in both eastern and western medicine. She has been prac-
ticing both types of medicine in Taiwan for over twenty years. She asked me several questions on the phone including whether I 
had a dry or wet cough, the color of my phlegm (if I had any) and my tongue color. A few days later, I received from her pack-
ages of Chinese herbs in a powdered form. I took the medicine, and after a week, my persistent cough was gone. Undoubtedly, 
my respect for Chinese Medicine grew after the experience. 
 
Traditional Chinese Medicine theory One of the classes for my first quarter is the theory of Traditional Chinese Medicine 
(TCM). In this class, I learned about the foundations of TCM including Yin Yang and the Five Elements: Water, Fire, Wood, 
Metal and Earth. The elements are also associated with five organs which are: Kidneys, Heart, Liver, Lungs and Spleen. The 
organs in TCM are not necessarily the physical organs in the body. The organs symbolize the functions of the names rather than 
the physical aspects. For example, Lung meridian acupuncture points run along the arm of the body. In the beginning, the theo-
ries seem abstract and far-stretched. However, as my education progresses, I realize that some aspects of the theories are very 
useful clinically. For example, TCM theory states that Liver opens into the eyes. TCM doctors believe that if a patient has eye 
problems, Liver is an organ to look into. The liver has more than 5,000 enzymes that affect metabolism, chemistry and nutri-
tional composition of the blood. One example is Vitamin A. Vitamin A enters the bloodstream, is picked up by the eye, and is 
converted into retinol, a substance that enables us to see. It is amazing to learn that although physicians during ancient time did 
not have scientific abilities to prove their theories, they were able to deduce treatments based on keen observations and rich ex-
periences.  
 
Hidden treasures One of my favorite classes in Meiji is Herbology. In this class, I learn about Chinese herbs that have been 
accumulated for thousands of years. We learn about qualities of herbs (bitter, sweet, cold, warm, salty, spicy or sour), channels 
of the organs they enter, actions and pharmacological researches. Majority of the herbs are derived from plants. It is exciting to 
learn about medicinal usages of herbs that are commonly known. For example, cinnamon can be used for joints pain, chrysan-
themum flower can be used as antibiotic for infections and relieve red, dry eyes and dandelion is a strong killer of bacteria. 
These herbs have been used for thousands of years, and currently, many pharmaceutical companies in China are doing re-
searches on herbs to determine their mechanisms and purify main ingredients for future medicine. Many of the herbs are derived 
from the plants that we encountered everyday. We just have to stop and pay attention to find these hidden treasures in our daily 
lives. 
 
What is in the future?  Like I mentioned before, many researchers in China are doing intensive researches to determine the 
pharmacological aspects of herbs that are known for thousands of years. Even now, herbs are incorporated into surgeries and 
other western medicine in China. Ironically, TCM still faces a lot of challenges in United States. Many people still prefer to visit 
a western doctor than see an eastern doctor. I believe both aspects of medicine have a lot to offer. Incorporation of herbs in sur-
geries in China is a perfect example of the integration of eastern and western medicine. If people can put away their prejudices 
and close-mindedness, I believe both fields of medicine will advance further together and give birth to a new wave of Integrated 
Medicine.  
 
 “When we try to pick out anything by itself, we find it hitched to everything else in the universe.” My First Summer in the Si-
erra  
 
If you have any thoughts regarding this article, please contact BAPS editors.  
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Looking Forward 
 
By Nyo Win, Ex-President, BAPS, 11/5/00 
 
Two years is a short time for me to serve BAPS; however, I have served the two full terms required of a BAPS president.  It is 
time to have a new leader with new ideas to continue the drive to push BAPS forward. We are pleased and fortunate to have 
Benny Tan as our next president of BAPS. BAPS is indeed in good hands. I’d like to take a moment to look at what has been 
done and to suggest what we may need to focus our attention on in the future.  
 
The key driver of BAPS is the dedicated team who put in their own time, their enthusiasm and their creative thinking. We 
have regular publication of the newsletter, seminars, societal and inter society events, the latter with enthusiastic attendance all 
the time. The BAPS newsletter is a shining example of the members’ dedication. Its success is public knowledge. Many read-
ers and members, those who I have been in contact or those who’ve contacted me, always tell me how they get the informa-
tion about our activities from the newsletter, how they know about BAPS through the newsletter and how the newsletter get 
them connected directly or indirectly to the Burmese American community. It is very enlightening to see two events that oc-
curred in the recent past: 
 
The first one was the volunteering of BAPS to help take care of the funeral of a fellow Burmese American professional, a pro-
fessor from San Jose State University. This is a sad story: The professor was a loner. He’d got his Ph.D. and secured a teach-
ing job with the University. He was in his prime age when he died. At this age not that many people would think anything 
could happen to take away his life. As far as one could imagine nothing in the world would need him to worry or to care. He 
wanted to be left alone, not to be bothered and not to be disturbed. Unfortunately, unexpected things did happen. He died at an 
unexpected death. No one was there to know what had happened, because few knew him and he knew only a few. That 
was the tragedy. BAPS, after receiving a very short notice, was able to volunteer both manpower and resources to help take 
care of the funeral and cremation of the deceased.  
 
The second one was an unprecedented successful RIT (Rangoon Institute of Technology) Alumni world wide Grand Reunion 
and Saya Pu Zaw Pwe (Paying Homage to the Teachers) held recently in the Bay Area. Over three hundred people, including 
Sayagyis, Sayamagyis, Sayas, alumni and family members from all over the world attended the reunion and Saya Pu Zaw 
Pwe. The event was in a large part organized and led by a group of BAPS members, including the newly elected BAPS Presi-
dent Benny Tan and Vice President Maurice Chee, who are also RIT alumni. That the event was well run and successful 
should attribute to a significant part to the organizing ability and the experience of the members seasoned in running BAPS.  
 
BAPS has come a long way. BAPS is now a large professional organization and is very visible in the Burmese American com-
munity. People come to BAPS for help such as the professor case. People have confidence in BAPS that we can make big 
things happen such as the RIT Grand Reunion and Saya Pu Zaw Pwe. We should also note that another critical success factor 
was the generous donation from many of us without which it would be very difficult if not impossible to succeed.  
 
Looking forward, we should capitalize on the recognition that we’ve gained from the community. We feel that we can do a 
good job to help out fellow Burmese Americans in case of need. We see that BAPS has the ability to serve a larger Burmese 
American community. We are getting the full moral and financial support of the Burmese American professionals and the 
community. We can start thinking about extending our reach to more professionals of other disciplines beyond what BAPS 
has already had, creating a general fund for helping people who one day may be in need, acquiring a permanent location for 
BAPS where people can go and meet each other.  I believe BAPS will be an outstanding organization that will be successful 
in serving the Burmese American professionals and the community in the future.  
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MICROSOFT EXCEL QUICK TIPS AND TRICKS 
Contributed by Willie K. Wong  

 
 

Author’s note: Special thanks to peers and former classmates for their time and contribution. I must admit that I do not have an 
in depth knowledge of Excel. One thing I learned out of this is that “No matter what you know, you don’t know enough in today 
fast-paced technology”. I deeply regret to announce that this will be my last article as a B.A.P.S member since I will no longer 
be member of B.A.P.S as of 12/31/00. Hours of time have been spent to compile information for article. Lack of feedback from 
readers is a contributing factor to my decision not to contribute any future article(s).   
 
• An easy way to insert and delete rows and columns in Excel 
In Excel, the easiest way to insert or delete entire rows or columns (rather than partial rows and columns) is to use keyboard 
shortcuts: [ctrl]+ and [ctrl]-. Specifically, you drag across the row numbers or column letters in the worksheet frame to select the 
rows or columns you want to insert and delete. Then, press [ctrl]+ to insert entire rows or columns at that spot. Press [ctrl]- to 
delete the entire selected rows or columns. You’ll find this approach much more convenient than pulling down a menu and 
choosing options from a dialog box. 
 
• Applying style to cells 
Like in Word, you can apply a style to cell formatting. This makes it easier to be consistent in spreadsheet presentation and 
change the formatting at will. 
 
Format | Style – Alt +’ (apostrophe)  
 
• Auto correction of commonly misspelled words and typed data 
Are you a bad typist? Well, Excel has a feature for you: the Auto Correct feature. To access this feature, select the Tool | Auto 
Correct menu bar option. This will bring up the AutoCorrect dialog box. Your insertion point will be positioned in the box enti-
tled Replace. Simply type (as usual) the wrong word in this section. For instance, you can type parallel in this box. Now press 
[tab] to go to the entitled With, and in this box type parallel. As soon as you enter data into the With Box, you’ll notice that the 
Add button becomes available. Click this button. You’re done. You can add all your favorite mistakes so they’ll automatically 
be corrected for you. If you make a mistake entering the data in either the Replace or With box, select the entry in the list and 
click Delete. When you’re done making changes in the AutoCorrect dialog box, click OK to exit.  
 
• Automatic Backups 
Excel makes backing up easy. Next time you save a workbook – say, mybook.xls – select File, Save As, and click on the Op-
tions button. Select Always Create Backup; click on OK, click on save, then click Yes to replace the existing file. Later, when 
you make changes and save the workbook again, the file already on disk is renamed Backup of workbook again, the file already 
on disk is renamed Backup of mybook.xlk, and the version in memory is written to disk as mybook.xls. You now have mybook.
xls and a one-generation backup copy named Backup of mybook.xlk.  
 
• Change the orientation of your text 
If you’ve ever needed to fit more columns onto a page by rotating your text to an angle or just wanted to add visual appeal to a 
spreadsheet, you’ll want to try this feature. Until the release of Excel 97, text in a spreadsheet always appeared horizontally. 
Now it’s possible to change the angle of the text in your worksheets. First, choose the cell or range of the cells that you want to 
rotate by highlighting them. Next, Choose Format – Cells from the menu bar and click the Alignment tab on the Format Cells 
dialog box. Now adjust the angle of the text by dragging the orientation line in the direction that you want to angle your text and 
click OK. You can also specify the angle by typing the angle in degrees.  
 
• Change the width of multiple columns 
If you want all the columns in your worksheet to be the same width, first click the Select All button, which is rectangle in the 
upper-left corner of your worksheet at the intersection of the row and column headings. Then, move the mouse pointer to the 
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line that separates any column headings. When the mouse pointer changes to a resizing tool, click and drag to resize all the col-
umns on your sheet. If you want to resize just a group of columns, select their column headings and then use the resizing tool. 
These techniques work for changing row heights as well. 
• Changing the default number of worksheets in an Excel workbook 
You can change the default number of worksheets in worksheets in a workbook in Excel. From the Tools menu select Options 
and then click the General tab. Use the sheets New Workbook text box to specify the new default number of sheets. The number 
of sheets can range from 1 to 255. I haven’t seen anyone using 255 worksheets in a workbook. 
 
• Cloning a formula across a range of cells 
If you want to clone a formula across a range of cells then select the range of cells, enter the formula then select the range of 
cells, enter the formula then press Ctrl + Enter – this will copy the formula into each cell. Relative references will be changed in 
each cell, just like in a normal copy. 
Fill the selected range with the current entry …. Ctrl + Enter 
 
• Copying the contents of a table view from Microsoft Outlook into Excel 
If you want to copy the contents of a table view from Microsoft Outlook into Microsoft Excel, try this: Put your Contact folder 
in Phone List view, select several contacts, and select Edit, then Copy; then switch into Microsoft Excel and paste.  
 
• Copying from the above 
There are two Excel shortcuts that copy details from the cell immediately above the current cell. One copies the formula while 
the other only copies the value. 
Copy FORMULA from cell above … Ctrl + ‘ (apostrophe) 
Copy VALUE from cell above … Ctrl + Shift + “ (quotation mark) 
 
• Create an Excel table within a Word document for tables that will change often 
If you are creating a table with numbers that you may need to change often in the future, you can create an Excel table within a 
Word document and link it to an Excel spreadsheet or workbook. Simply cut and paste from Excel into Word the needed table or 
section or your spreadsheet, and every time Excel is updated, Word will update the embedded table as well.  
 
• Create links in Excel to Microsoft Outlook contacts 
Suppose you have a worksheet that contains a column of names, some of which are entered as contacts in Outlook. You can con-
vert each name in the worksheet into a hyperlink that opens the corresponding contact’s form in Outlook. For instance, suppose 
cell H2 contains the name John Doe, which happens to be one of your contacts in Outlook. To create a hyperlink that will open 
that person’s contact form, select cell H2 and press {Ctrl] K to display the insert Hyperlink dialog box. In the Link to File or 
URL text box, type Outlook:Contacts/~John Doe and then click OK. When you click on cell H2, which is now a hyperlink, the 
Outlook contact form for John Doe will appear. 
 
• Creating a customized background for documents 
Create a customized background for your document is a mouse click away. You can put texture into Microsoft Excel charts, for 
example, and inside any shape you create with the Office drawing tools. To textures a chart background, right-click on the chart. 
Click Format Plot Area, the Fill Effects button, and the Texture tab. Choose your texture, click twice, and it appears as the back-
ground. 
 
• Create your own formatting style 
If you’ve ever wanted to create a formatting style that’s different than any of the currently available styles, you’ll be glad to 
know that there’s an easy way to do it. First, select the cell that has the combination of formats that you want to include in the 
new style. Then, choose Style from the Format menu and in the Style name box, type a name for the new style. To define and 
apply the style to the selected cells, click OK. To define the style without applying it, click Add, and then click Close. Also, if 
no cells have the formats you want for the style, you can specify the formats when you name the style. 
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• Displaying the Formula Palette 
If you’re typing a formula and need some help remembering the format of the function, just type the function name as part of the 
formula then use this shortcut to display the ‘Formula Palette’ which gives details of the function and shows the current values 
for each parameter as you enter it. 
 
Display Formula Palette – Ctrl + A (only works when entering/editing a formula) 
 
• Easily add a command to a menu 
Excel makes it easy to add commands to your menus. First, select the toolbar that contains the menu you want to add a com-
mand to. Next, Open the Tools menu, choose Customize, and then click the Commands tab. Then, in the Categories dialog box, 
click the category for the command. Now, simply drag the command you want from the Commands box over the menu on the 
toolbar. When the menu displays a list of menu commands, point to the location where you want the command to appear on the 
menu on the toolbar, and then release the mouse button. 
 
• Easily add a header and footer to your worksheet 
Previous versions of Excel had both a header and footer by default. In Excel 97, the default is no header and no footer. However, 
if you want to add a header or a footer, here’s what you do. From the menu bar select File – Page Setup. When the Page Setup 
dialog box appears, click on the Header/Footer tab. You can select a pre-set header or footer by clicking on the drop-down ar-
rows. If you want to type in your custom header or footer, click on the customize header or customize footer buttons, type the 
information that you want to appear in the header or footer and click OK. 
 
• Easy Microsoft Excel Formatting 
If you want to copy the formatting of one cell in Microsoft Excel to another, you don’t have to bother with Excel’s Format 
Painter button. Instead, just use Control-C to copy formats and Control-V to paste them. 
 
• Eight time-saving keyboard shortcuts 
Excel has lots of useful shortcut keys that perform various actions. The more you know, the more time you can save. Here are 
eight shortcuts we hope you find useful: 
 
- To enter the current date into the active cell, press [Ctrl]; 
- To enter the current time, press [Ctrl][Shift]; 
- To enter or edit a cell comment in the active cell, press [Shift][F2] 
- To quickly copy an entry into a cell directly to the right, select that cell, then press [Ctrl]R 
- To quickly copy an entry into cell directly below it, select that cell, then press [Ctrl]D 
- To copy an entry from cell directly above the active cell, you can press [Ctrl]’. If the entry is a formula, this shortcut makes an 
identical copy of that formula, rather than adjusting the cell reference relatively. 
- Pressing [Ctrl][Shift]’ also copies an entry from the cell directly above the active cell. However, if the entry is a formula, this 
shortcut copies the result of the formula only rather than the formula itself. 
- An easy way to view all formulas in a worksheet without having to select the cell containing it is to press [Ctrl]~. Press the 
shortcut again to switch back to the normal view. 
 
• Enter numbers with decimal places or trailing zeros 
If you’ve ever wanted to enter many numbers with a fixed number of decimal places or large whole numbers with a fixed num-
ber of trailing zeros (0). You’ll be glad to know that there’s an easy way to do it. On Excel spreadsheet Go to the Tools menu 
and choose Options. Now, then click the Edit tab and select the Fixed decimal check box. In the Places box (next to the Fixed 
decimal check box), enter the number of digits you want to appear to the right of decimal point. If you want to include zeros (0) 
automatically when you enter large whole numbers, specify a negative number to indicate the number of zeros. For example, to 
have Excel automatically insert 5000 when you enter 5, enter –3 in the Places box. Now, Excel inserts a decimal option point at 
the indicated position or inserts the specified number of zeros. In this example, -3 represents 3 zeros. However, data you entered 
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before selecting the Fixed decimal option is not effected. Thus you may turn this option ON/OFF anytime you wish. Now, when 
you finish entering numbers with decimal places or zeros, simply return to the Tools menu, choose Options, click the Edit tab 
and uncheck the Fixed decimal check box. Isn’t that simple? You can do this a lot faster than what I can explain to you folks. 
 
• Excel Delete Cells 
Delete Cells dialog box – Ctrl + 
 
• Excel Insert Cells 
Caution: Inserting cells in excel always needs to be done with care, do you want to shift existing cells, insert and extra row or 
column? 
Insert Cells dialog box – Ctrl ++ 
 
• Forceful recalculations 
We’d like to remind you of an important shortcut that forces a worksheet to be fully recalculated. 
Force recalculation --- Ctrl + Alt + F9 
 
Note: This is a particular concern since the Excel 97 recalculation bug was revealed. Visit Microsoft website for further details. 
You need to use this shortcut to make sure that all cells are updated. 
 
• Instant Keyboard Menus in Microsoft Excel 
PRESSES F10 on an extended keyboard and you have instant keyboard access to all of Excel’s menus. Once you’ve activated 
the menu bar by hitting F10, you can move to any menu by typing the letter underlined in the Menu name, Windows style. For 
example, to access the Options command, for example, you can press F10, then T (for the Tools menu), and then O (for Op-
tions). You can use the arrow keys to move down menus or from menu to menu. Just imagine this. You are working on your 
spreadsheet. All of a sudden, your mouse screw up and not responding. You can use this F10 keystroke to save your document 
before you reboot your PC. 
 
• Hip hyperlink hook-ups 
Some people find the automatic creation of web and mail links in Office 97 to be a nuisance. If you switch it off (in word 97 
look at Tools | AutoCorrect | AutoFormat as you type) then here’s a quick way to enter a hyperlink when you want one. 
 
Insert Hyperlink --- Ctrl + K 
Note: This works across Office 97 – Word, Excel and PowerPoint. 
 
• Jumps between pages 
When you are in Print Preview mode and zoomed in on the page you can use the arrow keys to move around the page. If you’re 
viewing the entire page (zoomed out) then try these shortcuts to more between pages: 
 
Jump to previous page – Ctrl + PageUp 
Jump to next page – Ctrl + PageDown 
Jump to first page – Ctrl + UpArrow 
Jump to last page – Ctrl + DownArrow 
 
• Need a bit more screen space – why not switch off the Standard toolbar temporarily 
Show/Hide Standard Toolbar – Ctrl + 7 
 
• Password Protection 
To protect your workbook from unauthorized changes, save it securely. Choose Save As from the File menu, click on the Op-
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tions button, and enter a case-sensitive password of up to 15 characters in the Password to Modify field. Click on OK, confirm 
it, click on OK again, then click on Save. Anyone who opens this workbook is told that it belongs to you. Without the password 
they can click on Read Only to modify but not to overwrite original. They have to save the spreadsheet with a different name. I 
see this a lot in Corporate environment where several forms such as Expense Reimbursement Form, Health Care Change Form 
… etc. at your company website where you only have READ access to those forms and NOT WRITE access to them. 
 
• Navigating Excel 
Don’t bother tabbing through the empty cells in a Microsoft Excel spreadsheet. Hold down the Control key when pressing the 
Up, Down, Left, or Right Arrows keys to leapfrog over empty cells and move directly to the next nonadjacent filled cell in a row 
or column. Use these keystrokes within a block of data to jump to the edge of the current block. 
 
• Moving or copying contents of a cell 
When you pass your mouse pointer over the lower right corner of a cell, you’ll notice that your mouse pointer shape changes. 
When the mouse pointer changes to a white arrow, you can click on the contents of the cell, and drag and drop the information 
to a new cell. If the mouse pointer changes to a bold plus sign (+), you can copy that information, either sideways or up and 
down, by dragging your mouse pointer over the number of cells you want to copy to and releasing the mouse button. 
 
• Handy END mode movements 
END mode is a curious but handy backwater of Excel. When the End key is pressed, some keys change the way they behave. 
For Example, press END then an arrow key – Excel will jump to the next non-blank cell in that direction. It comes in handy for 
jumping around the blocks in your worksheet. 
 
• Excel’s file compatibility between versions 
Spreadsheet users who share their data with others will enjoy the file compatibility between Microsoft Excel 97 and previous 
versions of Excel. If others you work with use an earlier version of Microsoft Excel or another spreadsheet program, you can 
change the default file format that Microsoft Excel 97 uses when saving workbooks. For example, if many people in your com-
pany still use Microsoft Excel version 5.0, you can save your Microsoft Excel 97 workbooks in the version 5.0 workbook for-
mat. All workbooks will be saved in the default format unless you specify a different file format in the Save As dialog box (File 
menu). 
 
• Setting Excel’s Print Area 
Have you ever printed a worksheet that had very little data on it, but that produced lots of blank pages? Or tired to print a large 
worksheet and only received output for a small range? Chances are somebody changed the print area for the sheet. Normally, 
Excel prints the range that accommodates all your data; nothing more and nothing less. Selecting a print area overrides this. To 
reset Excel to print all your data, select File/Print Area/Clear Print Area. 
If you want to set up a print area so you can consistently print just a specific part of a worksheet, first select the area you want to 
print. Then, choose File/Print Area/Set Print Area. From now on, only the selected range will be printed. 
 
• Trick for breaking a spreadsheet’s long text entries into separate lines 
For those Excel users who include large amounts of text in your spreadsheet, you’ll want to be sure and note this trick. You can 
break a long text entry into separate lines by positioning the cursor in the cell entry (or on the formula bar) at the place where 
you want the new line to start and pressing Alt + Enter. Excel expends the row containing the cell (and formula bar above) when 
it starts a new line. When you press Enter to complete the entry or edit, Excel automatically wraps the text in the cell, according 
to the cell column width and the position of the line break. 
 
• Open Office 
You can open a Web page from the File | Open dialog box of any Office application by typing the URL for the page in the File-
name box. Bear in mind that most Web pages will look unimpressive in Word and lousy in Excel, but you can save, convert, and 

Microsoft Excel Quick Tips and Tricks…..………………….…...continued on page 11 
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manipulate data from a Web page with an Office application in ways you can’t with a browser. 
 
• Quick formatting solution 
One of the most common things you do in Excel is format the current or selected cells using Format | Cells – here’s the quick way 
to get there. 
Format | Cell – Ctrl + 1 
 
• Selected multiple worksheets without a mouse 
If you’re constantly switching between sheets in an Excel workbook, try these keyboard shortcuts instead of using your mouse: 
 
[Ctrl][Page Down] moves to the next spreadsheet 
[Ctrl][Page Up] moves to the previous spreadsheet 
[Ctrl][Shift][Page Up] or [Ctrl][Shift][Page Down] moves and selects spreadsheets 
 
 
 
 

Send your feed back and/or comments to Willie K. Wong at whsclub@pacbell.net 
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